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More than 4.5 million companies use QuickBooks, making it by far the most widely 

used accounting system in the world. However, many CPAs frequently overlook or

underutilize the product’s strongest features. Are you using QuickBooks efficiently 

and getting the most you can out of the product? Following is a list of 15 

QuickBooks intermediate and advanced features that you should be using.

1. Memorize Transactions

For every company, a significant number of transactions recur regularly, and

QuickBooks accommodates this by enabling you to memorize recurring 

transactions. For example, suppose a company makes the same monthly rent 

payment, bills clients for recurring monthly services or records the same monthly 

depreciation entries. In these cases, QuickBooks can memorize the transactions 

and automatically enter them for you at regularly scheduled intervals. This feature

can help save time, reduce mistakes and increase accuracy. You also can use this feature to memorize complex 

journal-entry templates, such as detailed allocations, and enter the actual amounts later. To access the tool, type 

Ctrl + M.

Memorize Transaction tip. Memorize Transaction will generate electronic payments or paper checks but it does 

not automatically send or print them. Once a check is created in QuickBooks, you can send or print the check 

using the File menu’s Send Documents or Print Documents menu options.

2. QuickBooks Loan Manager

Many small businesses record loan payment transactions improperly, failing to separate the loan payment into the 

proper interest and principal portions according to the loan amortization schedule. Loan Manager provides a 
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solution that enables you to set up each loan with its associated parameters, such as term, rate, fees, 

compounding, balloon payments, etc. Thereafter, Loan Manager will generate the correct loan payment check 

each payment period, once again saving time, reducing mistakes and increasing accuracy. To access the tool, go

to the Banking menu, Loan Manager.

3. Process Multiple Reports

Often, bookkeepers who do a good job of keeping the books fail to consistently produce and distribute the 

necessary financial reports each day, week or month for company personnel to use in managing the business. In 

many cases, the process of preparing and printing dozens of reports is too time-consuming. QuickBooks provides 

a solution called Process Multiple Reports, which enables users to group together dozens of reports (using the 

Memorize function) and print them all in a single step, as shown below. To access the tool, go to the Reports

menu, Process Multiple Reports.

Multiple Reports tips. When memorizing each report, include the recipient’s name in the report title to make

distribution a little easier. In addition, re-sorting the reports in the Memorize Report window will ensure that the 

reports print in collated order.

4. Prevent Prior-Period Changes

A common issue with QuickBooks is how easily users can (intentionally or unintentionally) enter or edit 

transactions in prior periods. To prevent unauthorized prior-period entries or changes, set up a unique username 

and password for each user and set each user’s preferences to prohibit him or her from bypassing the closing 

date. Thereafter, by establishing a password-protected closing date and moving it forward each month as review 

and adjustments are completed, you can lock down the prior-period data as the year progresses, as shown in the 

screenshot at the bottom of the previous page. To access the tool, go to the Company menu, Set Closing Date.
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5. Custom Data Fields

I often have found custom fields to be one of the most powerful features in accounting software. QuickBooks 

Premier provides 20 generic custom data fields, and QuickBooks Enterprise provides more than 50 content-

specific custom data fields. Using these data fields, a clever CPA can overcome many shortcomings in an 

accounting system. For example, a boat marina might use custom fields to track the name of the customer’s boat 

and slip number and to create a data field indicating whether the customer subscribes to the monthly cranking 

service (see screenshot below).

Further, QuickBooks allows users to filter reports using those custom data fields. For example, the boat marina 

could filter a list of customers to display only those who subscribe to the monthly cranking service, thereby 

producing a list of boats that need cranking each month. To use the tool, go to the Customer Center, select a 

Customer, click the Edit Customer button, then under the Additional Information tab, click Define Fields.

Custom Data tip. Information entered into custom data fields can also be included in financial reports, on

invoices and in all QuickBooks documents.
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6. Batch Invoicing

QuickBooks versions 2011 and higher enable users to create a batch of invoices in a single process. For 
example, a company that needs to invoice 500 customers each month for a $20 Webhosting fee can generate all 
500 invoices in one step. The batch invoice feature also allows users to search for customers according to custom
data fields and then invoice the resulting group. For example, this would empower the boat marina’s bookkeeper 
(as mentioned above) to invoice in a single step each customer who subscribes to the monthly cranking service. 
To access the tool, go to the Customers menu, and select Create Batch Invoices (see screenshot atop the next 
column).

7. Editing Templates

Invoices, sales orders, purchase orders, customer statements and other documents are referred to as templates 
in QuickBooks. These templates can be edited by rearranging the document and by adding additional columns, 
data fields, text, images and custom data fields. For example, it may be beneficial to edit the company’s invoice 
template to include the sales representative’s name and phone number, additional columns for quantity and rate, 
or back-order information in the event of partial shipments. A knowledgeable user will review the templates and 
enhance them in an effort to best meet the company’s needs. To access the tool, go to the Lists menu, 
Templates, right-click on a template and select Edit Template, then click the Layout Designer button.

Templates tip. The templates screen provides an option for downloading additional templates from the Web, as 
well as colorful themes for enhancing all of your templates.
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8. Remote Access

QuickBooks Remote Access is a Web-based service (go to tinyurl.com/m7ljuf) that allows CPAs to securely log in 
to their clients’ QuickBooks systems. Remote Access grants the CPA entry only to the client’s QuickBooks 
application and data and prevents the CPA from viewing other data, such as Word, Excel and email files, on the 
client’s computer. The service takes only a few minutes to set up and, thereafter, the CPA can log in to the client’s 
QuickBooks to train users, review the client’s books and, if appropriate, enter corrections and adjustments.

In my experience, using Remote Access is a better solution than using the QuickBooks Accountant’s Copy 
method, for several reasons. First, the CPA avoids the need to have the client’s edition of QuickBooks running. 
Second, the CPA and client do not have to send the Accountant’s Copy files back and forth. Third, Remote 
Access provides full access to the client’s data in real time. Further, Remote Access makes it easier for the CPA 
to provide monthly and on-demand services throughout the year. In contrast, the Accountant’s Copy approach 
often leads the CPA to be involved with the client’s books only at yearend. (Note: Remote access is priced 
starting at $3.95 per month.)

Remote Access tip. This type of remote access gives the CPA control of the client’s screen, allowing the client to 
see the CPA’s mouse actions as the client is trained remotely via the telephone.

9. Stratifying Reports

QuickBooks provides a Columns tool that can stratify financial reports by numerous column configurations. This 
functionality is valuable for analyzing and scrutinizing a company’s financials. For example, a single column profit-
and-loss statement can be quickly transformed into an 81-column profit-and-loss statement—with a separate 
column for each of 80 customers and a total column at the end. Likewise, that same report could be restratified to 
display a column for each inventory item, thereby reporting the profit (or loss) for each item (or group of items). 
Other options include stratifying columns by month, quarter, year, departments, sales representatives and more 
(see screenshot below). Surprisingly, many popular, high-end accounting systems and enterprise resource
planning applications fail to provide this type of beneficial reporting. To access the Columns tool in any financial 
report, click on the Columns dropdown menu above the report.
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10. Using Account Numbers

As an option, QuickBooks allows you to display seven-digit account numbers in addition to 31-digit alphanumeric 

account names. The benefits are faster data entry (using a 10 key) and the ability to control the sort order of 

accounts displayed in financial reports. For example, you could use this feature to dictate that the accumulated 

depreciation account appears below property and equipment, not above. To use the tool, go to the Edit menu,

Preferences, Accounting, Company Preferences tab, and check the Use account numbers box, as shown 

below.

However, activating this option also includes account numbers in the financial statements and reports, which is 

not always desirable. To suppress account numbers, edit each account and add an account description, then set 

the Reports-Show Accounts by preference to Description Only. After that, only the account descriptions, 

instead of account numbers and names, will appear on all financial statements.

Reporting tip. The “Description Only” preference setting can be used to display customized row descriptions on 

financial statements; for example, you may prefer “Trade Receivables” instead of “Accounts Receivable.”

11. Fixed Asset Manager

Every company has assets, and the QuickBooks Fixed Asset Manager (included in the Accountant and Enterprise 

editions) can track those assets according to six methods (federal, state, book, adjusted current earnings, 

alternative minimum tax and other). The system incorporates many tax methods, such as the accelerated cost 

recovery system, the modified accelerated cost recovery system, and the IRC Sec. 168(f)(1) and Sec. 179 

depreciation methods, among others. Upon asset dispositions, the system can calculate the appropriate gain or 

loss on sales, as well as the appropriate amounts of depreciation recapture. Although fixed-asset data can be 

integrated with QuickBooks, many companies tend to use the Fixed Asset Manager as a stand-alone product—

which I recommend because the effort setting up integration probably takes more time than it saves during the

year—and enter manual depreciation entries each month in QuickBooks. To access the Fixed Asset Manager, go 

to the Accountant menu, Manage Fixed Assets.
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12. Attach Documents

The Attach Documents feature enables you to attach electronic documents throughout QuickBooks to achieve a 

paperless environment. As documents are processed, you can save them locally on your computer network or to 

a cloud-based storage facility accessible by all users, even those in remote locations. Some of the advantages to 

maintaining a paperless accounting system are:

a. Electronic documents can be available to all users, even remote users;

b. You can locate electronic documents quickly via indexed searching;

c. Electronic documents are easier to include when preparing reports or email messages, reducing the 

costs associated with making copies and sending paper documents;

d. Electronic documents can be easily backed up off-site for better data protection; and

e. Electronic documents reduce costs related to paper documents such as filing cabinets, file rooms and 

archiving efforts.

There used to be a charge associated with this feature, but the new QuickBooks 2012 Pro offers Attach 

Documents with free local storage, as Intuit is phasing out the cloud option. To use the tool, click the Attach 

button with the paper clip icon in any document or template. This option is grayed out until setup is completed.

13. Imported Credit Card Transactions

Typing a lengthy credit card statement into your accounting system is time-consuming and difficult to accomplish 

without making transposition or keypunching errors. By contrast, in most cases, credit card transaction data can 

be imported directly into QuickBooks in just a few seconds, and QuickBooks’ built-in logic can automatically match 

the expenditures with the appropriate vendor and account number for more efficient processing. This feature is 

included for free. To access, go to the Banking menu, Enter Credit Card Charges and click the Download 

Credit Card Charges option at the top of the page. Your specific setup and monthly procedures will vary 

depending on the credit card company you use.

14. Intuit Data Protect

New as of QuickBooks 2011, Intuit’s Data Protect service automatically backs up your QuickBooks data (or all of 

your computer files, up to 100 gigabytes) daily to a Web-based storage location. The Data Protect service differs 

from the older QuickBooks Online Backup service in that the backup procedure runs even when your data file is 

open, and each daily backup is saved for 45 days. To download Intuit Data Protect, go to tinyurl.com/4yy9z9y. 
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Once installed, choose File, Backup. Note: Prices range from $4.95 to $9.95 per month.

15. Prepare Letters and Envelopes

The Prepare Letters and Envelopes tool provides an assortment of templates and mail-merge capabilities for 
generating custom letters targeting customers, vendors, employees and others. Examples of the included 
templates are “Scheduled delivery notice,” “Bounced check” and “Late payment reminder.” You can also use this 
tool to create customer-specific letters such as new products or service announcements and invitations for 
selected customers to attend special VIP sales events. To access the tool, go to the Company menu, Prepare 

Letters and Envelopes.

J. Carlton Collins (carlton@asaresearch.com) is a technology and accounting systems consultant and a JofA
contributing author.

To comment on this article or to suggest an idea for another article, contact Jeff Drew, senior editor, at 

jdrew@aicpa.org or 919-402-4056.

QuickBooks Keyboard Shortcuts

Keyboard shortcuts represent the fastest way to navigate QuickBooks. The following charts contain several useful 
shortcuts:
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The QuickBooks Learning Center

The QuickBooks Learning Center provides a wealth of information to help you use the product. QuickBooks 2011 

includes 60 educational videos (averaging 4.5 minutes each) that do a good job of demonstrating the basic 

QuickBooks functionality; even seasoned QuickBooks consultants report that they have learned many additional 

points by watching these videos. For example, three videos demonstrate the processes of creating invoices, 

managing inventory and managing sales taxes. These tutorials are accessible in the Help menu’s QuickBooks

Learning Center, as shown below.

You also can download the QuickBooks Installation and Setup Guide; QuickBooks 2012: The Official Guide; and 

the Payroll Getting Started Guide. These three guides total more than 600 pages and provide detailed, step-by-

step instructions and screen images that explain the bulk of the functionality within QuickBooks. The guides are 

handy reference materials when using QuickBooks’ intermediate-to-advanced functionality, and are accessible via

links provided in the QuickBooks Learning Center.

AICPA RESOURCES

JofA articles

� “Technology 2012 Preview: Part 2,” Dec. 2011, page 30

� “Technology 2012 Preview: Part 1,” Nov. 2011, page 46

� “Tax Matters: IRS Addresses Accounting Software Audit Concerns,” July 2011, page 74

� “Tax Matters: AICPA Calls for Accounting Software Safeguards in IRS Audits,” June 2011, page 68

Use journalofaccountancy.com to find past articles. In the search box, click “Open Advanced Search” and then 

search by title.

Conference

Practitioners Symposium and TECH+ Conference in partnership with the Association for Accounting Marketing 

Summit, June 11–13, 2012, Las Vegas

For more information or to register, go to cpa2biz.com or call the Institute at 888-777-7077.
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IT Center and CITP credential

The Information Technology (IT) Center provides a venue for CPAs, their clients, employers and customers to 

research, monitor, assess, educate and communicate the impact of technology developments on business 

solutions. Visit the IT Center at aicpa.org/infotech. Members who want to maximize information technology to 

increase efficiency and boost profits may be interested in joining the IT Membership Section or pursuing the 

Certified Information Technology Professional (CITP) credential. For more information about the IT Membership 

Section or the CITP credential, visit aicpa.org/CITP.

More from the JofA:

Find us on Facebook  |  Follow us on Twitter  |  View JofA videos

Copyright © 2013 American Institute of Certified Public Accountants. All rights reserved.

Page 11 of 11A Quick Guide to Quickbooks

1/11/2014http://www.journalofaccountancy.com/Issues/2011/Dec/20114555.htm?action=print


